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SMS 13.3 Tutorial 

Bridge Scour 

Use the Bridge Scour Tool 
 

Objectives  

This tutorial demonstrates how to prepare to use the bridge scour tool by setting up a bridge scour 
coverage. 

Prerequisite Tutorials 

 Overview 

 Map Module 

 SRH-2D 

Required Components 

 SMS Core 

Time 

 15–25 minutes 
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1 Introduction 

This tutorial demonstrates creating a bridge scour coverage to use for exporting bridge 
scour values to the Hydraulic Toolbox to use in analyzing a bridge site. Bridge scour 
arcs will be created in a specific order. The coverage properties will then be defined. 
Computations will be completed, and the final scour values will be exported to the 
Hydraulic Toolbox. While some explanation is provided about various options and 
settings, please see the SMS User Manual for detailed explanations. 

The data used in this tutorial is from the Gila River in the state of New Mexico in the 
United States. The projection for the project has been preset. 

2 Getting Started 

Start by importing a project file containing the data for this simulation:  

1. Launch the SMS application.  

2. Select File | Open… to bring up the Open dialog. 

3. Select “Project Files (*.sms)” from the Files of type drop-down. 

4. Browse to the data files folder for this tutorial and select “GilaRiver.sms”. 

5. Click Open to import the project and exit the Open dialog. 

The project should appear similar to Figure 1. The contoured area near the center is 
the location of the pre-generated mesh. 
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      Figure 1      Initial project 

3 Creating the Bridge Scour Coverage 

A bridge scour coverage can be created by either duplicating an existing coverage or 
by creating a new coverage. This example will start with a new coverage. Create a new 
bridge scour coverage by doing the following: 

1. Right-click “  Map Data” and select New Coverage to bring up the New 
Coverage dialog. 

2. Select Generic | Bridge Scour in the Coverage Type section. 

3. Click OK to close the New Coverage dialog. 

4. If a welcome dialog appears, click OK to close the welcome dialog and bring up 
the Bridge Scour Coverage Properties dialog. 

5. Click OK to accept the defaults and exit the Bridge Scour Coverage Properties 
dialog. 

The various parameters in the Bridge Scour Coverage Properties dialog will be 
discussed later in the tutorial. 

4 Creating the Bridge Scour Arcs 

There are six types of bridge scour arcs: contracted section, approach section, 
centerline, bank, abutment toe, and pier. These arcs should be defined in that order to 
take advantage of the automatic type assignment done by the bridge scour coverage. 
The arc type can be changed manually, if needed, in the Bridge Scour Arc Attributes 
dialog. 

In order to facilitate quick completion of this tutorial, the Annotations module has been 
used to create a number of different arcs that can be used as templates for the bridge 
scour arcs. Simply follow along them when creating each arc in order to create the arcs 
in the correct locations (Figure 2).  
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      Figure 2      Bridge scour arcs labeled 

There are six types of bridge scour arcs shown in Figure 2: 

 A – Contracted section 

 B – Approach 

 C – Centerline  

 D – Bank (there are four in this case) 

 E – Abutment toe (there are two in this case) 

 F – Pier 

The creation of each of these arcs will be demonstrated below. 

4.1 Contracted Section Arc 

The contracted section arc is created at the maximum contraction of flow through the 
bridge constriction within the bridge limits. The maximum contraction may occur 
downstream of the bridge. It begins on the left side of the stream (looking downstream), 
where the projected edge of the stream intersects with the roadway. It travels along the 
roadway until it reaches the same intersection on the right side. When viewing the 
feature attributes of this arc, it will provide the stations of the bank arcs and abutment 
arcs, if they are defined. 

The contracted section arc must be created in the correct direction: from the left side of 
the river to the right side, as if looking downstream. The contracted section arc is 
created at the maximum contraction of flow through the bridge constriction within the 
bridge limits. 

1. Turn on “  Annotation Data” in the Project Explorer. 

2. Select “  Bridge Scour” to make it active. 
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3. Zoom  in to the area near the bridge, as shown in Figure 2. 

4. Starting on the left side of the river (at the end with the “A” at the top of the 
screen in Figure 2) and using the Annotations arc as a template, use the Create 

Feature Arc  tool to create the contracted section arc as shown in Figure 2. 
Double-click to end the arc. 

5. Turn off “  Annotation Data” in the Project Explorer. 

When the arc is completed, it should appear similar to the one in Figure 3. Ignore the 
pier near the center of the arc. There is a hole in the mesh at that location since water 
cannot flow there.  

 

      Figure 3      Contracted section arc 

This can be verified by doing the following: 

6. Using the Select Feature Arc  tool, double-click on the contracted section arc 
to bring up the Bridge Scour Arc Attributes dialog. 

7. In the Arc Type Options section, verify that “Contracted Section Arc” is selected 
in the Type drop-down. 

8. In the Gradation Options section, click Define Soil Gradation… to bring up the 
Bridge Scour Soil Gradation dialog.  

9. Enter “5” as the Number of Points. 

10. Enter the values from the Sediment Particle Diameter column below into the 
same column in the Bridge Scour Soil Gradation dialog: 
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 Sediment Particle Diameter (ft) Percent Passing (0.0–1.0) 

1 0.000771 0.05 

2 0.00327 0.16 

3 0.0393 0.5 

4 0.258 0.84 

5 0.360 0.95 

11. Click OK to close the Bridge Scour Gradation dialog. 

12. Click Close to exit the Bridge Scour Arc Attributes dialog. 

13. Click anywhere other than on the contracted section arc to deselect it. 

14. Turn on “  Annotation Data” in the Project Explorer. 

4.2 Approach Arc 

As with the contracted section arc, the approach arc must be created from the left side 
of the river to the right side as if looking downstream. 

1. Using the Create Feature Arc  tool, create the approach arc (labelled “B” in 
Figure 2) from left to right as if looking downstream. Use the Annotations arc as a 
guide. 

2. Using the Select Feature Arc  tool, double-click on the approach arc to bring 
up the Bridge Scour Arc Attributes dialog. 

3. In the Arc Type Options section, verify that “Approach Arc” is selected in the 
Type drop-down. 

4. In the Gradation Options section, click Define Soil Gradation… to bring up the 
Bridge Scour Soil Gradation dialog.  

5. Enter “5” as the Number of Points. 

6. Enter the values from the Sediment Particle Diameter column below into the 
same column in the Bridge Scour Soil Gradation dialog: 

 Sediment Particle Diameter (ft) Percent Passing (0.0–1.0) 

1 0.000771 0.05 

2 0.00327 0.16 

3 0.0393 0.5 

4 0.258 0.84 

5 0.360 0.95 

7. Click OK to close the Bridge Scour Gradation dialog. 

8. Click Close to exit the Bridge Scour Arc Attributes dialog. 

9. Click anywhere other than on the approach arc to deselect it. 

10. Turn off “  Annotation Data” in the Project Explorer. 
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The project should appear similar to Figure 4. The approach arc is the arc on the left. 

 

      Figure 4      Approach arc is on the left 

11. Turn on “  Annotation Data” in the Project Explorer. 

4.3 Centerline Arc 

The centerline arc must be created from upstream downstream. Do this by:  

1. Using the Create Feature Arc  tool, create the centerline arc (labelled “C” in 
Figure 2) from left to right (upstream to downstream). Use the Annotations arc as 
a guide. 

2. Using the Select Feature Arc  tool, double-click on the centerline arc to bring 
up the Bridge Scour Arc Attributes dialog. 

3. In the Arc Type Options section, verify that “Centerline Arc” is selected in the 
Type drop-down. 

4. Click Close to exit the Bridge Scour Arc Attributes dialog. 

5. Click anywhere other than on the centerline arc to deselect it. 

6. Turn off “  Annotation Data” in the Project Explorer. 

The project should appear similar to Figure 5. The centerline arc is the dashed arc 
going diagonally, then mostly horizontally, to the right. 
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      Figure 5      Centerline arc (dashed) crossing the approach and contracted section arcs 

7. Turn on “  Annotation Data” in the Project Explorer. 

4.4 Bank Arcs 

Four bank arcs will be created by doing the following: 

1. Using the Create Feature Arc  tool, create the first bank arc (lower arc 
labelled “D” crossing the approach arc in Figure 2). Use the Annotations arc as a 
guide. The arc direction is not important. 

2. Repeat step 1 for each of the other three bank arcs (labelled “D” in Figure 2). 
Use the Annotations arc as a guide. 

3. Using the Select Feature Arc  tool, double-click on one of the bank arcs to 
bring up the Bridge Scour Arc Attributes dialog. 

4. In the Arc Type Options section, verify that “Bank Arcs” is selected in the Type 
drop-down. 

5. Click Close to exit the Bridge Scour Arc Attributes dialog. 

6. Repeat steps 3–5 for each of the other three bank arcs. 

7. Turn off “  Annotation Data” in the Project Explorer. 

The project should appear similar to Figure 6. Two bank arcs should be crossing the 
approach arc and two more should be crossing the contracted section arc near the 
edges of the bridge. 



SMS Tutorials  Bridge Scour 

 

 Page 9 of 13 © Aquaveo 2023 

 

      Figure 6      Four bank arcs (indicated with arrows) 

8. Turn on “  Annotation Data” in the Project Explorer. 

4.5 Abutment Toe Arcs 

Two abutment toe arcs should be created by doing the following: 

1. Zoom  in to the bridge area (Figure 7).  

2. Using the Create Feature Arc  tool, create the top abutment toe arc (upper 
arc labelled “E” in Figure 2). Use the Annotations arc as a guide. The arc 
direction is not important. 

3. Repeat step 2 to create the lower abutment toe arc, using the Annotations arc as 
a guide. 

4. Using the Select Feature Arc  tool, double-click on the upper abutment toe 
arc to bring up the Bridge Scour Arc Attributes dialog. 

5. In the Arc Type Options section, verify that “Abutment Toe Arcs” is selected in 
the Type drop-down. 

6. Click Close to exit the Bridge Scour Arc Attributes dialog. 

7. Repeat steps 4–6 for the lower abutment toe arc. 

8. Turn off “  Annotation Data” in the Project Explorer. 

The project should appear similar to Figure 7. Two abutment toe arcs should be 
crossing the contracted section arc near the bank arcs at the bridge. 
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      Figure 7      Two abutment toe arcs (indicated by arrows) 

9. Turn on “  Annotation Data” in the Project Explorer. 

4.6 Pier Arcs 

The final arc to be created is the pier arc (in this tutorial, there is only one) by doing the 
following: 

1. Using the Create Feature Arc  tool, create the pier arc (“F” in Figure 2). Use 
the Annotations arc as a guide. The arc direction is not important. 

2. Using the Select Feature Arc  tool, double-click on the pier arc to bring up the 
Bridge Scour Arc Attributes dialog. 

3. In the Arc Type Options section, verify that “Pier Arcs” is selected in the Type 
drop-down. 

4. In the Pier Options section, enter “1.5” as the Pier width. 

5. Click Close to exit the Bridge Scour Arc Attributes dialog. 

6. Turn off “  Annotation Data” in the Project Explorer. 

The project should appear similar to Figure 8. The pier arc should be within the hole in 
the mesh near the middle of the bridge. 
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      Figure 8      The single pier arc 

To see all of the bridge scour arcs at once, do the following: 

7. Frame  the project. 

8. Zoom  in to the area shown in Figure 9. 

The project should appear similar to Figure 9. 

 

      Figure 9      All of the bridge scour arcs visible 
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5 Bridge Scour Properties 

All of the required bridge scour arcs have now been created. Before exporting the file 
for the Hydraulic Toolbox, some additional properties should be set. These settings 
create defaults for a number of different settings within the Hydraulic Toolbox so that 
the same information does not have to be entered multiple times. 

5.1 Input  

These are the basic inputs based on datasets within the project as well as soil 
gradation that must be entered manually. 

1. Right-click on “  Bridge Scour” and select Bridge Scour Properties… to bring 
up the Bridge Scour Coverage Properties dialog. 

Start with creating a scenario. Multiple scenarios can be created and ran at the same 
time. Using scenarios is covered in more detail in another tutorial. 

1. Select “MeshEC” from the Mesh drop-down. 

2. Click the Add  button to bring up the Select Tree Item dialog. 

3. Select “Q25EC” folder item from the list and click OK to open the Edit Bridge 
Scour Scenario dialog. 

Selecting the solution folder will auto-populate this dialog with the appropriate dataset 
when available. 

4. Click Close to exit the Edit Bridge Scour Scenario dialog. 

5.2 Model Specifications and Output 

These parameters tell the Bridge Scour tool how to complete the computations: 

1. In the Model Specifications section, select “Bank Width Ratios” from the 
Contraction Scour Variable Extraction Approach drop-down. 

2. Under NCHRP Abutment Scour Condition, select “Scour Condition a (Main 
Channel)” for both the Left Abutment and Right Abutment. 

In order to use the Hydraulic Toolbox, an output file must be created. Do the following 
to set the name of the output file: 

3. In the Output filename section, click Browse… to bring up the Choose file dialog. 

4. Select “Hydraulic Toolbox Files (*.hyd)” from the Files of type drop-down. 

5. Enter “GilaRiver-output.hyd” as the File name. 

6. Click Save to exit the Choose file dialog. 

Notice that the entered filename now appears to the right of the Browse… button. 

5.3 Compute and Export Scour Values 

Now that the basic input data has been set, the bridge scour calculations can be made:  

1. In the Scenarios section, select the “Q25EC” scenario and click View Values… 
to compute the bridge scour values and bring up an SMS dialog.  
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2. If desired, copy the information in this dialog by clicking pressing Ctrl-A followed 
by Ctrl-C. 

3. Open an external text editor and paste the information using Ctrl-V. 

This allows saving the calculated information so it can be reviewed at any time.  

4. Click OK to close the SMS dialog. 

To export the Hydraulic Toolbox file, do the following: 

5. Click Export Hydraulic Toolbox File.  

6. Click OK when advised the export is complete. 

The “GilaRiver-output.hyd” file will be saved to the location specified when entering the 
output filename. The default location is the same location as the project file (in this 
case, the data files folder). 

5.4 Advanced 

There are two buttons in the Advanced section:  

 Edit Advanced Options… – The advanced options will not be used in this 
tutorial. Please see the SMS User Manual for details on this button. 

 Delete Generated Arcs – Removes the arcs generated when exporting the 
bridge scour file or viewing the bridge scour values. This button does not delete 
the manually-created arcs.  

6 Viewing the Results 

The results file (in this case, “GilaRiver-output.hyd”) can be viewed in Hydraulic 
Toolbox 4.4.1 or later. This is available from the hydraulics software download page 
maintained by the Federal Highway Administration.

1
  

Please see the documentation for the Hydraulic Toolbox for information on the various 
viewing and results assessment options available. 

7 Conclusion 

This concludes the “Bridge Scour” tutorial. Feel free to continue to experiment with the 
SMS bridge scour tool, or exit the program. 

 

                                                      

1
 See https://www.fhwa.dot.gov/engineering/hydraulics/software.cfm for more details. 

https://www.fhwa.dot.gov/engineering/hydraulics/software.cfm

